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A step-by-step tutorial on how to create both 3D terrain and photo-realistic scenery for use in Condor 2.

CREDITS:  Many thanks to Mr. Luis Briones (a member of a Flying Club in Argentina), and special 
thanks to Mr. Nick Bonniere, a long-time Condor scenery pro who created a Condor 2 scenery for Lake
Placid.  Nick developed the Condor_tiles program and a lot of notes/description used in the tutorial.
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the Credits above.  Copyright (c) 2019, 2020  John Murtari.   Permission is granted to copy, distribute 
and/or modify this document under the terms of the GNU Free Documentation License, Version 1.3 or 
any later version published by the Free Software Foundation; with no Invariant Sections, no Front-
Cover Texts, and no Back-Cover Texts. A copy of the license is included in the section entitled 
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Goal:  Create a scenery for Harris Hill Soaring Corporation.
This tutorial will take you thru all the steps that were used to create a scenery for Harris Hill Soaring in 
Elmira, NY.   The home of Soaring in the United States and the location of Schweizer Aircraft.  Large 
sceneries at high resolution take a lot of processing power and time.  In this case we’ll be creating a 
57x57 mile landscape with the Harris Hill airfield (4NY8) at the center.

At the end of this tutorial we’ll have flyable scenery with 3-D terrain which has been overlaid by photo 
scenery.  For those of you who have used Condor, it will NOT have any actual 3-D objects like trees, 
hangars, runways.  We will not do any special thermal modeling.  Hopefully, those additions to this 
tutorial will come later (maybe from you!)…

Part One:  Creation of 3-D terrain
This part will first get your computer setup for landscape creation with the needed landscape creation 
tools and documentation.   We’ll then go thru the steps necessary to create a flyable 3-D terrain of the 
correct size

Step Zero:   Download the tools and guides needed

If you’re a Mac/Apple person, sorry, most of these tools only run under Windows.  Graphics 
processing is a difficult task for a PC.  You should have a reasonably fast processor and at least 8 
Gigabytes of RAM and room on your hard drive.  A completed scenery can easily use several 
Gigabytes of disk space.

1) Download the tool set and documentation for landscapes from the condorsoaring.com site, unpack in
a different directory from where Condor2 is installed

1a) Download a Legacy texture tool from Nvida that will be needed.  Unpack the zip in the same 
directory where you installed the landscape editor above.  When you are done the LandscapeEditor.exe 
and nvdxt.exe should be in the same folder.

2) Download and install the QGIS program version2.18.28, x64 from 
→https://www.soaringtools.org/downloads/QGIS-OSGeo4W-2.18.28-3-Setup-x86_64.exe .  We won’t
use most of it, but one of the utilities it contains will be used by Condor_tiles later.  Although there are 
newer versions of this software, make sure you get version specified.                                                       

3) Download and install Google Earth Pro for the desktop →  https://www.google.com/earth/versions/  
Scroll down on the versions page and choose the desktop download.  This is a great tool for 
visualizing/measuring your landscape.

4) Download the Condor_tiles program and unpack.  It can be found in the downloads section on the 
SoaringTools web site  → http://www.  SoaringTools.org/index.php/downloads/  
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  Step One:  Determine the coordinates for the scenery

Although we will be building the Harris Hill scenery, it’s likely you’re already thinking about 
making a small scenery for your local area. It’s relatively simple to use this tutorial as a model and 
substitute your own area. The steps are the same, just the naming is different. If you’re going to do this,
it might be good to learn a bit more about the structure of Condor2 sceneries so that you understand 
what is happening at each step (see details in Appendix 1).

Briefly, the unit of Condor2 scenery is the tile. Each tile is 23 km x 23 km (14.29 mi x 14.29 
mi), and a scenery is a rectangle of row x col tiles. This is important because as you choose the size of 
your initial scenery you want the sides of your rectangle to be multiples of the tile size. Also be aware 
that the outer edge of this rectangle is not usable (approximately ¼ tile), so when you think about your 
coordinates, take into account this margin.

You now have a potential area selected. Because the earth is round and our maps are flat, we 
need a way to project that curved surface onto a flat area. The first goal is to determine your UTM zone
and then the latitude/longitude of the north west corner and south east corner of your landscape (also 
know as top left  and bottom right).  NOTE:  It can be OK if your scenery crosses into another UTM 
zone by a small amount.  Just be sure to use the UTM zone # where the majority of the scenery is 
located in the steps below.  There may be some minor distortion.

Use this to find your Universal Transverse Mercator Zone (UTM) and measure distances →  
https://mangomap.com/robertyoung/maps/69585/what-utm-zone-am-i-in- 

For Harris Hill we want  at least a 9 tile landscape (3 x 3).  Each Condor landscape tile is 
14.2915 miles/23 km square, so we want to have a square app. 42 miles on each side.  Now remember, 
the Earth is not FLAT, so our square is approximate and the tools will compensate for that. Make sure 
you have a little extra.  Start from you center point and measure out 23 miles N,S,E,W (46 miles/side)

You can use the UTM lookup site above for that, also Google Earth is very handy.   Here is 
what we have for Harris Hill and the yellow pins define the two corners.  Take the time to make SURE 
you get the coordinates right.  In this case we have the below.  BE CAREFUL not to confused Degrees/
Decimal minutes/seconds below with other format which give individual degrees, minutes, seconds.  
Some tools like a certain format – many are happy to take the wrong format and convert to a bad 
location….. beware!

This web site is your FRIEND in conversions →   https://www.pgc.umn.edu/apps/convert/         

NW Pt:   42°25'26"N / 77°24'26"W or 42°25.438’N / 77°24.434’W or 42.423968 / -77.407247

SE Pt: 41°48'41"N /  76°25'32"W or 41°48.699’N / 76°25.545’W or  41.811661 /  -76.425757

WARNING: Don’t skimp on this step, some bad numbers here will cost you late
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Step Two:  Convert to UTM coordinates, confirm proper size

With those corners defined, we now start to build the landscape.  The Lat/Lon we have are 
approximate.  We do not need to get exact numbers by converting to UTM and making sure we are on 
a boundary.

Create a folder in the Condor2\Landscapes directory to hold your scenery.  In this case we call it hhsc1 
(you can substitute your own scenery name in the examples).

1) Start Condor_Tiles.  
• In the “Landscape” box, choose the folder you just created above.  
• Some settings:  Imagery/Tiles,  Tile Zoom/16, Tile size/8192, GeoData/OSM. 
• On just the first run you need to define two paths. Using the ‘Browse’ buttons set:

Condor_Path → Set it to the location of your Condor2 install, usually C:\Condor2

GDAL library Path → This is a geodata processing package that was installed as part of 
QGIS. If you’ve installed QGIS 2.18 you should find this path:  C:\Program Files\QGIS 
2.18\bin
If you’re having a hard time finding it, do a Windows search for gdalwarp.exe

Mine looks like this when done.  The displayed paths look incomplete, but it’s all there.
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2)   In Condor_tiles click on the “DEM Helper” button in the lower right. This will bring up a new 
screen.  Make the following entries:

       a) In the bottom left “Range Margin” choose “None” (we should have already compensated that
the last 5.76Km or 3.6 miles will be unflyable around the border of your landscape).

      b) In the upper left “Desired Area Selection” choose “By Coordinates” and enter the values just 
as we recorded earlier.  Use the degree/decimal values, latitude for North/South, longitude for 
West/East.

c)  Then click the box ‘To UTM’, do not check the box “TL BR” – you will then see values fill 
in the upper right side in the box “Condor UTM Range”.  (TL – Top Left, BR – Bottom Right 
coordinates are used for extents instead of the overall largest extents)

d) Then click “Check/Show” and you will see a grid pattern in the box labeled “Condor 
Latitude/Longitude”.    Explanation follows.

The numbers in the upper right box are called Easting/Northing values.  The earth is divided into 60 
UTM zones, HHSC is in 18N, and your exact location in the zone is defined by the Easting(X Coord) 
and Northing(Y Coord).  So the values above express the exact coordinates of the corners and for our 
Condor landscape they need to be on whole numbers.

The bottom right box shows the rounding that occurred.  Our original values (the Blue Box) put us 
closer to a 4x4 terrain.  The outer black grid shows the landscape has been expanded to 4x4.  The red 
box shows the actual flyable area (remember, you can’t reach the edge of a landscape).  We could try to
shrink it in Latitude and Longitude for a 3x3, but we’ll accept the 4x4. 

We need to store the Easting/Northing values.  GOOD IDEA to take a screen snapshot to you have all 
the values, including lat/lon of the corners.

 NW Corner:   295296 (Easting) <the West value>,  4710833(Northing) < the North value>
 SW Corner:    387456 (Easting) <the East value>,  4618673 (Northing) <the South value>
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3)  In the lower right click on “Make KML” to make a Google-earth map file.  It will be stored in 
Landscapes/hhsc1/working/DEM/OverAllMap/OverAll.kml  
You’ll need Google Earth to open and see the file.  It should agree with what you expect. 
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Step Three:  Download terrain data and create terrain files

1) Click on “Make DEM”  (lower right part of the
window) while in the “DEM Helper” window to
create a batch file to run the GDAL library
routines.  Check the message box in the main
Condor_tiles window for files you need to
download.  

DEM: Will need to download the following
STRM files:
N41W078.hgt
N41W077.hgt
N42W078.hgt
N42W077.hgt
DEM: Condor V2 batch file created.
DEM: Columns: 3072
DEM: Rows: 3072
DEM: UTM_Zone: 18 N
DEM: UTM_Right: 387456
DEM: UTM_Bottom: 4618673
DEM: 90m Terrain UTM_Right: 387426
DEM: 90m Terrain UTM_Bottom: 4618703 
 

 

DEM → Digital Elevation Model

At this point some files have been created for your new scenery.  Check the ../Working/DEM folders 
and you see the batch file (DEM.bat).   It contains the commands necessary to created the actual 3-D 
terrain for the area you specified.

2) You next need to download this data from a NASA website.  We’ll be use Space Shuttle Radar 
Topography Mission data (SRTM).

a) First go to → https://dwtkns.com/srtm30m/ 
You can zoom in to your location and then click to see the tile name, we need four tiles as 

shown in the message above: 
 N41W078.hgt, N41W077.hgt, N42W078.hgt, N42W077.hgt
                                                                                                                                                             

b) When you click to download, you’ll first need to create a login account with NASA. Save the
files (.zip) in the DEM directory where the .bat file is located.  
NOTE: At times downloads from the USGS servers may fail.  They do offer pretty responsive tech 
support.  If you have a problem, let them know here → https://ers.cr.usgs.gov/feedback/

Start a “Command Prompt” window.  After download you should now have this directory contents:       
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C:\Users\jm>cd c:\Condor2\Landscapes\hhsc1\Working\DEM

c:\Condor2\Landscapes\hhsc1\Working\DEM>dir (your dir display may have different columns)

  
-rwxrwxr-x+ 1 jmurtari None     2188 May 11 10:58 DEM.bat
drwxrwxr-x+ 1 jmurtari None        0 May 11 10:52 KML
-rwxrwxr-x+ 1 jmurtari None       87 May 11 10:50 LatLong.txt

-rwxrwxr-x+ 1 jmurtari None 10602217 May 11 11:03 N41W077.SRTMGL1.hgt.zip
-rwxrwxr-x+ 1 jmurtari None 11545464 May 11 11:03 N41W078.SRTMGL1.hgt.zip                  
-rwxrwxr-x+ 1 jmurtari None  9441928 May 11 11:03 N42W077.SRTMGL1.hgt.zip
-rwxrwxr-x+ 1 jmurtari None  9575162 May 11 11:02 N42W078.SRTMGL1.hgt.zip
-rwxrwxr-x+ 1 jmurtari None      264 May 11 10:58 scenery.hdr

                                                                                                                    
c) Next unzip the files and you should have four .hgt files.  You may need to rename these files 

to match what is expected, e.g. N41W078.SRTMGL1.hgt → N41W078.hgt     When done you should have 
4 new files in the same directory as above:

-rw-r--r--+ 1 jmurtari None 25934402 Oct  8  2012 N41W077.hgt
-rw-r--r--+ 1 jmurtari None 25934402 Oct  8  2012 N41W078.hgt
-rw-r--r--+ 1 jmurtari None 25934402 Oct  8  2012 N42W078.hgt
-rw-r--r--+ 1 jmurtari None 25934402 Oct  8  2012 N42W077.hgt

d) Then run the DEM.bat file in a command prompt window – you should see quite a bit of 
output .   Just showing sample output from the start of execution:
                                                                                                                   
c: \Condor2\Landscapes\hhsc1\Working\DEM>DEM

C:\Condor2\Landscapes\hhsc1\Working\DEM>setlocal

C:\Condor2\Landscapes\hhsc1\Working\DEM>set PATH=C:\Program Files (x86)\Common Files\
Oracle\Java\javapath;C:\ProgramData\Oracle\Java\javapath;C:\WINDOWS\system32;C:\WINDOWS;C:\
WINDOWS\System32\Wbem;C:\WINDOWS\System32\WindowsPowerShell\v1.0\;C:\Program Files (x86)\
Common Files\Intuit\QBPOSSDKRuntime;C:\WINDOWS\System32\OpenSSH\;C:\Program Files\Git\
cmd;C:\John\emacs\emacs\bin;C:\Program Files (x86)\Intel\Intel(R) Management Engine 
Components\DAL;C:\Program Files\Intel\Intel(R) Management Engine Components\DAL;C:\Program 
Files\PuTTY\;C:\Users\jmurtari\AppData\Local\Microsoft\WindowsApps;;"C:\Program Files\QGIS 
2.18\bin"

C:\Condor2\Landscapes\hhsc1\Working\DEM>set GDAL_DATA=C:\Program Files\QGIS 2.18\bin\..\
share\epsg_csv

C:\Condor2\Landscapes\hhsc1\Working\DEM>rem convert HGT file to GeoTiff

C:\Condor2\Landscapes\hhsc1\Working\DEM>set sourceHGT=N41W078.hgt

C:\Condor2\Landscapes\hhsc1\Working\DEM>set destinationTIFF=T0.tif

C:\Condor2\Landscapes\hhsc1\Working\DEM>gdal_translate -of GTiff N41W078.hgt T0.tif
Input file size is 3601, 3601
0...10...20...30...40...50...60...70...80...90...100 – done.

<<< much more follows, should be no errors>>                                                 
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The following new files should be created:                                                                                             
 
-rwxrwxr-x+ 1 jmurtari None  2099695 May 11 11:10 UTM_cropped_90m.tif
-rwxrwxr-x+ 1 jmurtari None      604 May 11 11:10 UTM_cropped.raw.aux.xml
-rwxrwxr-x+ 1 jmurtari None 18874368 May 11 11:10 UTM_cropped.raw
-rwxrwxr-x+ 1 jmurtari None      679 May 11 11:10 UTM_cropped.hdr
-rwxrwxr-x+ 1 jmurtari None  2097152 May 11 11:10 UTM_cropped_90m.raw
-rwxrwxr-x+ 1 jmurtari None      604 May 11 11:10 UTM_cropped_90m.raw.aux.xml
-rwxrwxr-x+ 1 jmurtari None      683 May 11 11:10 UTM_cropped_90m.hdr

                                                                                                                             

3)                                                                                     
 Now you can use the two other buttons at the bottom of the DEM helper page. Click on Make Terrain 
(.TRN) to generate a Terrain file.  You will see a blue progress bar in the main Condor_tiles window.

When that is complete click on Make Terrain (.TR3) to generate the heightmaps files that Condor2 uses
for elevation. Depending on the size of the terrain, this may take a few minutes.  Again, the progress 
bar will appear in the main Condor_tiles window. The following files and folders were created within 
c:/Condor2/Landscape/hhsc1
                                         
hhsc1.trn                                                                                                                                        
HeightMaps/ – a folder containing series of files starting with h0000.tr3 – h1515.tr3

These contain the terrain data for each tile.  You should be asking if our terrain is 4x4, that 
should only be 16 files, why are there 256!!!?   Because…. Condor2 subdivides each of the larger tiles 
into 4x4 subtiles.  So 16 * 16 = 256.

How do you relate the numbers to the actual terrain location, check Appendix ONE for a 
complete explanation.  Real quick →  The bottom right tile is “0000”, the first two digits are the row, 
the second two are the column.  The tile to the left of the bottom right tile is “0001” and the tile above 
the bottom right is “0100”.  The tile in the upper right corner is “1515” (remember, total of 16 subtiles 
numbered 0-15).

NICE JOB! – you can close Condor_tiles for now.
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Step Four:  Use the Condor Landscape Scenery Editor

In our last step we’ll actually finish creating a flyable terrain.  It won’t have any real scenery, 
but you’ll be able to see 3-D terrain and fly it in Condor2.

1)  Start the Landscape Editor, and from the Landscape popdown in the upper right, you should 
see your new Landscape, hhsc1, as an option. You should see something like below. It doesn’t 
look like much, but it’s actually showing elevation features in the terrain.

How to maneuver.  As you move the mouse around, you are presented with a lot of useful 
location information in the bottom bar.  The latitude and longitude values should agree with 
what you’re expecting.   By default, the editor puts you near the middle of the terrain.  To move
around select the “FINGER” and you can drag the terrain.  Notice the yellow lines delimit the 
larger 4x4 tiles, and the dashed lines show the 4x4 subtiles.

Click the left mouse button to zoom in, middle/right to zoom out.

                                                                                                                                                                      

3)  A landscape must have at least one Airport defined to be flyable in Condor 2.  Using another
tool like Google Earth you need to find the exact LAT/LON in decimal degrees for the middle 
of your runway, also the elevation (in meters).  Google Earth does give you the option of seeing
decimal degrees and meters.
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For hhsc1 I used the name 4NY8:   42.119522 /  -76.900490  (THIS SHOULD BE THE 
MIDDLE/CENTER of the runway), elevation:  523 meters(1715’),  length: 500 meters (1640’), 
direction: 331 True (340-9W variation), width: 36 m.                          

4) In the Landscape Editor, in the “View/Modify” box, check “Airports”.  Then put your mouse
in the blank area beneath and click right.  A menu should appear, select ‘Add’.   Then fill in the 
values and select OK.   It should appear on the map.

4a) OPTIONAL – you may want to flatten the runway terrain.  Choose “Height Map” and the 
map will show you elevation, zoom into the runway, it should be outlined.  Then click on the 
“FLATTEN” icon and set the radius no wider than the runway, and set the altitude to elevation 
(in meters) and a slope ratio (1:4 is good). As you sweep your mouse you’ll see two concentric 
circles: the inner one is the flattening area and the ring between the inner and outer one is the 
graduated slope. It’s helpful to get the immediate runway area flat for placement of objects and 
ease of towing.

5) Now just complete the steps in the “Condor Landscape Guide”. Make sure to follow the 
order below:

a) File → Export flightplanner map
b) File → Export forest map.
c)  File → Export thermal map.

            d)  File → Export textures to DDS (As the guide says, you’ll need the Nvidia legacy 
texture tools placed in the same directory with the LandscapeEditor.exe for this to work.  Say 
‘No’ to export only nonexisting, we want everything recreated.
             e) File → Export terrain hash
             f) File → Export forest hash  (NOTE: These steps are important as an anti-cheat 
mechanism. ALSO, if you ever try to fly Condor2 and your elevator doesn’t work, make sure 
you have exported these recently).

g) File → Save Landscape
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Step Five:  Take a test flight in Condor 2                                                           

Just a little more to do.  

1) You still need two more files in the main landscape directory. Condor_Tiles will automatically 
create  two dummy files you can edit as needed.  You just need to start Condor_Tiles and then choose 
the ‘Read Header’ button on the upper right side.  You should then see some messages and the files 
will be created if they are absent.

      Reading Terrain header...

UTM Zone:   18 N
UTM Bottom: 4618673
UTM Right:  387456
Height:     1024
Width:      1024
Resolution: 90
Delta X:    -90
Delta Y:    90

42 dummy centre tile airports \dhhsc1.apt created 

 hhsc1.ini –  Edit the text file and change Version to be something meaningful, e.g. 
Version=1.0

 hhsc1.cup –  This is another text file, which contains waypoint/turnpoint definitions. By default,
a dummy waypoint is placed in the center of the scenery.  See the appendix for the format of 
this file.

2)  Start Condor2 and select “FREE FLIGHT”.  In the upper right “Landscape” box you should now be 
able to select your scenery.

3)  TASK tab: You must define a simple task.  Click on “New” and then Click on your airport, move 
the mouse and it will create a line, Click again to create a turnpoint.  Just make a box, but end it by 
going to your airport and clicking again – you should get “Finish”

4)  NOTAM tab:  You can try an “Aerotow”, recommend change rope length to 200’.  We have not yet 
created a real airport, so the terrain and tow planes may not line up.  If it doesn’t work, choose 
Airborne.

5) “SAVE” the flightplan and then click “Start flight”

NOTE:  When the flight starts, check your flight controls.  If you cannot move the stick forward/aft 
please re-export all the items shown earlier in the landscape editor.  The lack of stick control is a 
security feature against ‘tampered’ sceneries….
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Part Two:  Photo Scenery creation

Step Zero:  Download extra needed tool.

There is probably a way to do this for FREE and I’m happy to update the tutorial.  For now you’ll need 
to spend a little money for a tools that makes downloading satellite imagery easier.

Go to http://AllMapSoft.com/ and download the “Google Satellite Maps Downloader.”  To create HI-
RES scenery as we will in this case, you’ll need the paid version.  Your version should be at least 8.346

Let it install to the default location, usually: C:\allmapsoft\gsmd

After it installs you’ll need to create a symbolic link to make it usable by other tools.  To do that you 
need to run a Command Prompt window as the Administrator.  
NOTE:  Use “Command Prompt” and not “Power Shell”.  Then give these commands:

C:\WINDOWS\system32>cd \allmapsoft

C:\allmapsoft> dir

 Directory of C:\allmapsoft

05/11/2020  01:31 PM    <DIR>          .
05/11/2020  01:31 PM    <DIR>          ..
05/11/2020  01:22 PM    <DIR>          gsmd

C:\allmapsoft> mklink /D gmid gsmd
symbolic link created for gmid <<===>> gsmd

C:\allmapsoft> dir

05/11/2020  01:32 PM    <DIR>          .
05/11/2020  01:32 PM    <DIR>          ..
05/11/2020  01:32 PM    <SYMLINKD>     gmid [gsmd]
05/11/2020  01:22 PM    <DIR>          gsmd

For Condor scenery generation, the concept is to get a set of these imagery tiles at a desired resolution 
for a given area to fit into Condor tiles of a desired resolution.   Review Appendix ONE for more info 
and a table of zoom/resolution in meters.

Step One: Create the commands necessary to download images

1) Start  Condor_Tiles  (IMPORTANT: click right and choose "Run as Administrator") To minimize 
the download data size, Condor_Tiles creates ‘symbolic-links’ for the imagery folders and needs 
administrator level for this step. 

     Pick the landscape name and Version should stay at V2 (this is for Condor2, not version 2 of your 
scenery.  
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     Pick the type of data imagery (we'll be using Tiles).
     Pick the desired Tile zoom level (we'll use 16 for high resolution)
     Pick the desired tile size for Condor, which should match closely to the zoom level (8192)

NOTE: High resolution uses of lot of disk space. Use zoom level 15 for large Landscapes, with a tile 
size of 4096.

 2) Click on 'Read Header' button to load the UTM data of the scenery extents

You should see something like this in the message area:

Reading Terrain header...
UTM Zone:   18 N
UTM Bottom: 4618673
UTM Right:  387456
Height:     1024
Width:      1024
Resolution: 90
Delta X:    -90
Delta Y:    90

  3) Click on the 'Make GMID' button to generate initial coordinate extent files for each tile.  These 
files will be used by the Maps Downloader.  Again, you can see the numbering coordinate system used 
for the files.  These are text files.  You will find them in the ./Working/SourceTiles

IMPORTANT NOTE: 
                                                            

CONFIRMATION CHECK:  Look at the contents of a file, the Lat/Lon coordinates should be 
as you expected.
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Step Two:  Download the image data.

NOTE: The latest version of  GoogleSatelliteMapsDownloader and Condor_Tiles allows us to 
automate much of this process.  To see details on the manual method, reference Appendix Two.

1) Condor_tiles has created a couple of batch files to automate the process in the :
GM c:\Condor2\Landscapes\hhsc1\Working\SourceTiles folder:

-rwxrwxr-x jmurtari   None  1250 May 11 11:56 ./Working/SourceTiles/GMID_ALL.bat
-rwxrwxr-x jmurtari   None  690 May 11 11:56  ./Working/SourceTiles/GMID_ALL_Combine.bat

Again, in a Command Prompt window, change to the tiles directory and run GMID_ALL:

> cd \Condor2\Landscapes\hhsc1\Working\SourceTiles
> GMID_ALL

Note that some of the batch files call other batch files, so you may not run all the batch files listed.

This takes about 30 minutes on a 4x4, 16 tile scenery.  You will see new windows open and close  for 
downloading and combining files as it works it’s way thru the process, e.g.

                                             

NOTE:  If the scenery has more than 30 tiles, it is possible the process will be interrupted as Google 
sets limits for downloads.  In that case you will have to wait 24 hours to resume.  You can just give the 
GMID_ALL command again, the tools will skip images that have already been downloaded.

2) At the end of the automatic process, you've created 16 .bmp files, one for each tile:
/cygdrive/c/Condor2/Landscapes/hhsc1>find ./Working/SourceTiles -name "*.bmp" -print
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./Working/SourceTiles/0000/0000_combined/0000.bmp

./Working/SourceTiles/0001/0001_combined/0001.bmp

./Working/SourceTiles/0002/0002_combined/0002.bmp

./Working/SourceTiles/0003/0003_combined/0003.bmp

./Working/SourceTiles/0100/0100_combined/0100.bmp

./Working/SourceTiles/0101/0101_combined/0101.bmp

./Working/SourceTiles/0102/0102_combined/0102.bmp

./Working/SourceTiles/0103/0103_combined/0103.bmp

./Working/SourceTiles/0200/0200_combined/0200.bmp

./Working/SourceTiles/0201/0201_combined/0201.bmp

./Working/SourceTiles/0202/0202_combined/0202.bmp

./Working/SourceTiles/0203/0203_combined/0203.bmp

./Working/SourceTiles/0300/0300_combined/0300.bmp

./Working/SourceTiles/0301/0301_combined/0301.bmp

./Working/SourceTiles/0302/0302_combined/0302.bmp

./Working/SourceTiles/0303/0303_combined/0303.bmp
                                                                                           

Step Three:  convert images to Condor tiles

Now each image is converted into a Condor tile, by 'warping' to UTM and 'cropping' to the desired size.

NOTE:  If you took a break in the process and just re-started Condor_tiles, make sure to select the 
proper landscape and click on the “Read Header” box.

This process is automated below, for information on the manual process see Appendix Two.  Also, note
that these batch files sometimes create messages such as “Cannot find file xxxx.xxx” or assorted Error 
messages. Not all of these messages are indicating failure of the programs. It’s best to run each step to 
completion and and then check to see if the indicated output has occurred before deciding there is an 
execution error.

With Condor_Tiles, click on Make GDAL but do not select a tile, i.e. leave the tile selector blank. 
Condor_tiles creates a batch file ‘GDAL_xxxx_TIF.bat’ in each tile folder  
..\Working\SourceTiles\xxxx and an overall batch file ‘GDAL_ALL.bat’ in the
..\Working\SourceTiles folder. 

Again, in a Command Prompt window, run  GDAL_ALL  to start the process.  For a scenery with a total 
of 16 tiles (4x4), it can take about 15 minutes.

When you're done, again 16 files created in a new directory, these will be large files, >200 Meg each.

jmurtari@anvil:/cygdrive/c/condor2/Landscapes/hhsc1>
./Working/Terragen/Textures/0000.bmp
./Working/Terragen/Textures/0001.bmp
./Working/Terragen/Textures/0002.bmp
./Working/Terragen/Textures/0003.bmp
./Working/Terragen/Textures/0100.bmp
./Working/Terragen/Textures/0101.bmp
./Working/Terragen/Textures/0102.bmp
./Working/Terragen/Textures/0103.bmp
./Working/Terragen/Textures/0200.bmp
./Working/Terragen/Textures/0201.bmp
./Working/Terragen/Textures/0202.bmp
./Working/Terragen/Textures/0203.bmp
./Working/Terragen/Textures/0300.bmp
./Working/Terragen/Textures/0301.bmp
./Working/Terragen/Textures/0302.bmp
./Working/Terragen/Textures/0303.bmp  
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Step Four:  create the final scenery

1) Run the Landscape editor, and pick the landscape, and then in Tools, 'Import tile sized textures'
   - the images in Working/Terragen/Textures will be loaded as the imagery.
   - this will replace the initial black-and-white terrain based imagery.

2)  You can check your airport placement with the imagery, and carefully adjust the lat/lon for the 
proper position.  

3) In the Landscape editor the run the same export commands as before.                                                  

            a) File → Export flightplanner map
b) File → Export forest map 
c)  File → Export thermal map 

            d)  File → Export textures to DDS (As the guide says, you’ll need the Nvidia legacy 
texture tools placed in the same directory with the LandscapeEditor.exe for this to work.  Say 
‘No’ to export only nonexisting, we want everything recreated. This will take about 40 minutes 
for a 16 tile scenery.

NOTE:  When this is done you can also use Condor_tiles to tune the runway position.  Start the 
program, pick the landscape, click on 'Read Header' and then 'Airport Place'.  A separate 
window will appear that allows you to make fine position adjustment using the arrow keys.   
You will see a blue line also, that is the tow plane track.   Make sure to save your changes!
             e) File → Export terrain hash
             f) File → Export forest hash  (These steps are important as an anti-cheat mechanism. 
ALSO, if you ever try to fly Condor2 and your elevator doesn’t work, make sure you have 
exported these recently).

g) File → Save Landscape

 

Step Five: Splash Screen and Imagery Credits

When Condor loads you see some large images displayed as the scenery is being loaded,  in the default 
Slovenia 2 landscape,  ‘Two burly guys in a glider!’

It’s easy to create your own.   We’d recommend at least 1920x1080 in size (HDTV/16:9 ratio) and JPG
format.  Your landscape has an Images subfolder.  It will be empty, but you can copy the files and they 
are used in random order.  As you see below, just use a number as the name, starting at 0 (zero).

 Directory of C:\Condor2\Landscapes\hhsc1\Images

05/12/2020  08:12 AM         1,714,475 0.jpg
05/12/2020  08:12 AM         1,528,563 1.jpg
05/12/2020  08:12 AM         2,053,719 2.jpg   
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See APPENDIX THREE about imagery usage.   Not real practical to put tags in the landscape that 
will never be seen.  We’d suggest adding some text somewhere on your Splash Screens to credit 
Google.   ALSO, don’t forget to give us a LITTLE LOVE!  We’d be happy if you’d share the source of
help, e.g.

Satellite images: Google Maps
Help from: SoaringTools.Org 

CONGRATULATIONS – you should have a flyable landscape!  If you'd like to share it, let us know 
and we'd be happy to  offer a download from our site.

Now you just need to create a nice airport/runways.  You can find some excellent tutorials on using 
the different Landscape utilities and how to  create a detailed airport  in their "Downloads" area ->  
https://www.condorsoaring.com/downloads-2/

Be prepared for some reading, the English version of the Airport Creation tutorial has over 130 pages!
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       OPTIONAL EXTRA PROCESSING
           None of these items are required, but they can enhance your scenery:

Easy Tool to Create Grass RunwayAdding a real runway

This can be a lot of work.  But if you need just a grass strip you can download Airport
Maker (by Jiří Brožek) from our site.  Just unpack to your desktop and you’ll see the
Icon.

In this example will assume the name of the Airport in your landscape is “Lawrence.” Then follow 
these steps.  

1. Start Airport Maker

2. In the Runway parameters box, enter the width and length (IN METERS!).

1.  Side marker count: 1

2. Corner makers: Outer

3. Marking style: Painted Grass

3. In the Grass surface, enter the size of any grassy area that surrounds the runway (experiment).
Use the “Offset” values to move the grass.

4. Windsock – change the offset values to move it’s position.                                                            

5. Generate OBJ Files -  A ‘Save as” dialog pops up.  You want to pick the Airports folder for 
your landscape (it should be empty if you’ve never created an airport).  Then enter the “File 
name” as “Lawrence”, do not choose anything for “Save as type”.  Press the “Save” button.

6. You should see these files in the Airports folder and can close Airport Maker;

LawrenceG.mtl*  LawrenceG.obj*  LawrenceO.mtl*  LawrenceO.obj*

7. You can close Airport Maker.

8. Convert the files to Condor format – As part of the “Condor Landscape Toolkit” you 
downloaded earlier in the tutorial, you will find the “Object Editor”.  Double-click and start the 
application.

9.  Choose “File” →  “Open Obj” 

1. Open the LawrenceG.obj, you’ll see some info appear. 

2. Select “File” → “Save to C3D” and the Airports folder should already be selected with the 
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proper file name.  Just press the “Save” button.

3.  Repeat the steps above for the LawrenceO.obj file.       

10.  You should now see two additional files in the Airports folder and can close Object Editor.

LawrenceG.c3d*  LawrenceO.c3d* 

11.  Those are the only two files required in the Airports folder, you can delete the others.

12.   Congratulation!  You should now see a real surface in Condor 2.  If you do not, or see 
blotches, check the ‘flattening’ of your airport area.  A bumpy surface will project above the 
runway.

Correcting artifacts in the imagery

NOTE: The Landscape Editor uses the nVidia nvdxt program to export DDS tiles. nvdxt has 
two bugs which can result in ‘water puddles’ on the landscape in dark spots, with 3 color 
compression instead of 4. A workaround is to use nvdxt with a different output (dxt5 instead of 
dxt1a ). 

Condor_Tiles generates a batch file ‘DDS_xxxx.bat’ in each tile folder 
..\Working\SourceTiles\xxxx and an overall batch file ‘DDS_ALL.bat’ in the
 ..\Working\SourceTiles folder. You can click on DDS_ALL as a work-around. 

NOTE: dxt5 DDS files are twice as large as dxt1 DDS files. Condor_Tiles provides a Utility to 
convert dxt5 DDS tiles to dxt1 DDS tiles which effectively reduces the file size by 50% and 
still maintain 4 color compression. 

Click on the Utilities button and click the dxt Convert button and select all (ctrl-A) the tiles in 
the Textures folder.

Creating custom thermal maps & forest maps

 You can create custom thermal/forest maps for Condor.  It can be a lot of work.  Condor_Tiles has 
some support for using publicly available data to automate the process.  Below are some notes.  As of 
this tutorial version, we have not tried it!

Helper_OSM_GEO.txt By Nick Bonniere

For thermal and tree maps, it can be done by hand, basically ‘painting’ forests, 
roads, fields, etc.. onto a background of each tile. This takes way too long, but 
will match the textures very closely. 

For a landscape in Canada, the Geogratis website can be used, but it only covers 
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the Canadian landmass.

An alternate way is to use the database from Open-Street-Maps which has shape files
for roads, lakes, rivers, forests, etc...  The database is not complete, but for 
some areas it is quite good. Whatever is missing can then be filled in manually.

In Condor-V1 the various maps had this resolution:

Terrain-map – 90m
Thermal-map – 90 m
Combined forest map with
- Deciduous Forest-map – 45m
- Coniferous Forest-map – 45m
Textures maps – variable resolution in Textures folder

In Condor-V2 the various maps have this resolution:

Terrain-map – 90m and .tr3 maps at 30m in HeightMaps folder
Thermal-map – 90 m
Combined forest maps in .for ForestMaps folder with
- Deciduous Forest-map – 11.25m
- Coniferous Forest-map – 11.25m
Textures maps – variable resolution in Textures folder

OSM ESRI shape files are available in a reasonable format from GeoFabrick. You can 
use OpenOffice database to look into the .dbf files to look for items of interest 
such as roads and rivers.The OSM shape files can be downloaded from GeoFabrik:

https://download.geofabrik.de/index.html

For the Pennsylvania Landscape Ridge-North-2 recently created, a downloaded of 
the .shp.zip is needed for the Pennsylvania state from North-America. Because the 
scenery extends around and south of Pennsylvania, the states of Maryland, Virginia 
and West-Virginia are also needed. Use Google-Earth for example to find all the 
states/regions that is needed.

It is possible to download a whole region or by state. It depends on what you want 
and how big it is.
The .shp.zip file type is what is needed.

https://download.geofabrik.de/north-america.html

pennsylvania-latest-free.shp.zip
maryland-latest-free.shp.zip
virginia-latest-free.shp.zip
west-virginia-latest-free.shp.zip

There is a button on Condor-Tiles ‘Make-Geo’, that creates a GeoDatabase folder and
creates batch files for each condor tile. You then unzip the shape files into the 
geodatabase folder and for each, change the name, if desired, such as 
Pennsylvania.shp for example. It is actually a folder that contains all the shape 
files.

In each sourceTile, there will be 3 batch files. One for thermal, GEO_t_0000.bat, 
one for deciduous forest GEO_V2_b_0000.bat, and one for coniferous forest 
GEO_V2_s_0000.bat. You can run these batch files individually or use the 3 batch 
files, GO_b.bat, GO_s.bat, GO_t.bat, in the GeoDatabase folder that call all the 
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individual batch files, one at a time.  It is best to start by doing one tile 
individually, and if it looks good, then run the overall batch file and go away for
a few hours, as all the tiles get generated.

Note that OSM has only a ‘forest’ definition, not a deciduous nor a coniferous 
distinction. A blank coniferous map will be generated as it is needed for the 
Landscape Editor.

You can view and modify the resulting tiles with Condor_Tiles with the ‘Edit 
Forest’ and ‘Edit thermal’. The background textures tile is shown and is overlaid 
with the thermal or forest. Press the ‘v’ key to toggle the overlay.

Because the shape lines are narrow, it is best to usually 'shrink' the forest which
provides more margin around lakes, rivers, roads, so that no tree ends up on roads 
or lakes, etc...

Forest maps end up in Working/Terragen/Forest folder, and with the landscape 
editor, you can import them, and then export the forests and export the forest-
hash.

Thermal maps stay in each SourceTile folder. There is a button on Condor_Tiles 
‘Make thermal’ that will generate the thermal map.  Each type of geographic 
structure is assigned a thermal value 0 to 255, basically a heat index for thermal 
generation. You can edit the default values if you want.

-----------------------------------------------------------------------------------
--------------------
Details about OSM data:

Open Office can be used to open the database file to have a look at details.

gis_osm_buildings_a_free_1 - (big file - OpenOffice  may crash)
gis_osm_landuse_a_free_1   - forest, orchard, 
                           - allotments, cemetery, commercial, farm, grass, 
industrial, meadow, 
                           - nature_reserve, park, quarry, 
                           - recreation_Ground, residential, retail, scrub, 
vineyard
gis_osm_natural_a_free_1   - beach, clifs, etc. Nothing useful
gis_osm_natural_free_1     - peaks, springs, trees, etc. Nothing useful
gis_osm_places_a_free_1    - village, town, locality, island, etc
gis_osm_places_free_1      - village, town, locality, hamlet, etc
gis_osm_pofw_a_free_1      - churches
gis_osm_pofw_free_1        - churches
gis_osm_pois_a_free_1      - park, golf course, graveyard, etc
gis_osm_pois_free_1        - restaurant, pub, hotel, university, etc
gis_osm_railways_free_1    - rail lines
gis_osm_roads_free_1       - (big file - OpenOffice crashes)
gis_osm_traffic_a_free_1   - parking
gis_osm_traffic_free_1     - crossings, junctions, turning circles, etc
gis_osm_transport_a_free_1 - railway stations, bus stations, etc
gis_osm_transport_free_1   - bus stop, railway stations
gis_osm_water_a_free_1     - river, lake, reservoir, bog, etc

gis_osm_waterways_free_1   - canal, river, stream, etc
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  APPENDIX ONE – General notes on Scenery Creation
by Nick Bonniere

1) A scenery is a made up of a group of tiles

2) Each tile is 23 km x 23 km (14.29 mi x 14.29 mi), which is actually a resolution
of 90 meters times 256 = 23.040 km
    
If you pick 4 tiles, I would suggest you offset the airport from the center a bit 
so it falls fully into one of the 4 tiles, otherwise it will be cut-up into 4 
pieces. Not absolutely necessary, just a suggestion so you can view the airport in 
one tile only.

3) The original resolution of 90 m is based on Space Shuttle elevation data (STRM)

4) Condor 2 uses a resolution of 30 meters, which is 3 times the resolution of 
Condor 1, and 30m STRM data is available

5) The last 1/4 tile edge of a scenery is not flyable. So if you have one tile, 
only the centre 1/2 or 11.5 km x 11.5 km is flyable, If you use 2 x 2 tiles, i.e 4 
tiles, 46 km x 46 km, only the centre 34 km x 34 km is flyable, etc...

6) The projection used is UTM, (Universal Transverse Mercator), This means that all
elevation data and photographic data needs to be converted to UTM coordinates. 

7) Tiles are in a grid of rows and columns starting at the bottom right corner 
(South East), which is tile 0000. The first two digits are the column number and 
the second two digits are the row number. Above tile 0000.bmp is tile 0001.bmp. The
tile to the left is tile 0100.bmp

8) You can use multiple resolutions. For LakePlacid, the centre tile is hi-res 
8192x8192, while all the other tiles are 4096x4096.  The file size increases by a 
factor of 4, 48MB file (at 4096) instead of 192MB (at 8192).
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9) Notes on Tile system zoom level and Condor resolution

                                                                          
- Tile system zoom level  (approximately)
- zoom level 1 - each pixel is 78184 m (equator), 55284 m (45 deg latitude)
- zoom level 2 - each pixel is 39092 m (equator), 27642 m (45 deg latitude)
.....
- zoom level 10 - each pixel is 152.7 m (equator), 108.0 m (45 deg latitude)
- zoom level 11 - each pixel is  76.3 m (equator),  54.0 m (45 deg latitude)
- zoom level 12 - each pixel is  38.1 m (equator),  27.0 m (45 deg latitude)
- zoom level 13 - each pixel is  19.1 m (equator),  13.5 m (45 deg latitude)
- zoom level 14 - each pixel is   9.5 m (equator),   6.7 m (45 deg latitude)
- zoom level 15 - each pixel is   4.8 m (equator),   3.4 m (45 deg latitude)
- zoom level 16 - each pixel is   2.4 m (equator),   1.7 m (45 deg latitude)

- Condor resolution
- tile size  256 - 23040 m, each pixel is 23040/256  = 90 m
- tile size  512 - 23040 m, each pixel is 23040/512  = 45 m
- tile size 1024 - 23040 m, each pixel is 23040/1024 = 22.5 m
- tile size 2048 - 23040 m, each pixel is 23040/2048 = 11.25 m
- tile size 4096 - 23040 m, each pixel is 23040/4966 = 5.625 m
- tile size 8192 - 23040 m, each pixel is 23040/8192 = 2.8125 m
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      APPENDIX TWO – manual run of downloader/combiner

In Part Two of this document (Photo Scenery Creation), Steps Two and Three cover the downloading 
of image data and how it is combined into tiles usable for Condor.  This is now an automated process, 
but below is more detail to cover the old manual method.

 Downloading images manually

1) Run the GoogleSatelliteMapsDownloader downloader.exe.    

a) Click on "Open Task" and select the Initial_0000.gmid file.  Make sure "Zoom level" is set to
16 (or whatever was selected earlier) and "Maps type" is Tiles.

b) After it opens change the "Task name;" box to keep the original since the file will be 
overwritten:

Initial_0000.gmid  to  0000.gmid  (YOU ARE NOT changing the actual file name, just the Task 
name.)
                                                                          
 c)  You should see LAT/LON values fill in (taken from the file), and they should make sense 
with your scenery location.

                                
  d) Click on "Start" to begin  the download process.
 You should see a "Downloaded" count in the lower left, it should eventually reach the "Total 
images" number.   If it seems to get stuck, or no progress, make sure you can reach the google site.

             e)   What's actually happening:

  - a folder 0000 will be created and a set files will be downloaded into that folde
  - these files are 256x256 images that cover the desired area, but actually cover more area than 
needed
  - at the end, the file 0000.gmid will contain the actual coordinate extent of the downloaded 
tiles 

 f) REPEAT the above steps for all 16 tiles – don't make any typos! Yes, this is a bit time 
consuming.  We're trying to convince them to create a command line version of the tool that 
could be used as part of a larger script.

2)  Still in the downloader.  Select "Tools -> Map Combiner", that will take care of merging all the 
individual 256x256 files.   

a) Select the "0000.gmid" file (NOT the one prefixed with "Initial_") and untick all image types
except bitmap.   For Automatic generation of Condor Tiles, also select TIFF image type.

b) REPEAT for all 16 tiles.                                                                           
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 Combining images

    1) Start Condor_tiles. To create the batch file that will do this, on Condor_tiles, pick the desired tile 
in the "Tile" section,  0000 in this case, and click Make GDAL

  - a batch file ./Working/SourceTiles/000/GDAL_0000.bat will be created.
  - double-click on the batch file and it will process the data
  - a new image 0000.bmp will be placed into the Working/Terragen/Textures folder

                                                                                                        
REPEAT for each tile, 0001, 0002, etc... 

 You can do these simultaneously if your PC has the memory.  Each is independent.

ALTERNATE:  If you have a unix shell available, a command similar to the below will process all.

jmurtari@anvil:/cygdrive/c/condor2/Landscapes/hhsc1/Working/SourceTiles> for dir in `ls -d 
0*`; do echo "#### Processing $dir"; cd 
/cygdrive/c/condor2/Landscapes/hhsc1/Working/SourceTiles/$dir; ./GDAL_$dir.bat; done

#### Processing 0000
…..

                       

                                                                                                                                       

Page 26 of 38



 APPENDIX THREE – Licensing, Google and Satellite Imagery
This tutorial uses imagery data collected by various satellite sources and compiled by Google and made
available for download.  We’re happy to acknowledge the great help that is.  Licensing can always be 
an issue (see link below for more info and references).

We certainly feel we are making ‘FAIR USE’ of their imagery and transforming it into a new product.  
That all being said we strongly advise NO COMMERCIAL use, e.g. You shouldn’t setup a website 
where people give you coordinates and you spit out a scenery they can download for a fee.  It might be 
OK, but it might not under FAIR USE.   

More on FAIR USE →     https://FreeGeographyTools.com/2007/fair-use-and-google-earth-imagery     

You can certainly acknowledge Google. We’d suggest adding some text somewhere on your Splash 
Screens, some have used: “Satellite Imagery – Google Maps”

            

                                                    

Page 27 of 38

https://freegeographytools.com/2007/fair-use-and-google-earth-imagery


    APPENDIX FOUR –  Distortion: Flat map over round earth

Some of you interested in enigmas and brain-teasers may be asking, “How can satellite photos of a 
ROUND Earth be flattened?”   Well just think back to older flat maps you’ve seen… mercator 
projections, etc…. 

by Nick Bonniere

     When you fly in real-life, you are flying over a sphere. When you fly in Condor, you are flying over 
flat terrain which is a projection of a sphere onto a flat surface. For Condor this projection is UTM 
(Universal Transverse Mercator). Just like for any flat map such as a paper map, the projection results 
in distortion. The further away from the centre point of the projection, the more the distortion and that 
is why you need to pick the closest UTM zone.

When images are downloaded, they have already been flattened based on a tile projection system. For 
use with Condor, they have to be re-projected to UTM. This is where epsg:3857 and espg:4326 come 
in. They refer to the projections and coordinates.  If you use the right one, you minimize distortions, but
if you use the wrong one, you introduce more distortion. Over small distances, the distortion is small 
and in a Condor tile (23040 metres wide), the difference between epsg:3857 and espg:4326 is about 10 
to 15 metres.

For your 5x5 scenery, you can determine the overall effect of the UTM projection. You take the lat-
long coordinates of opposite corners and do a great-circle calculation, and for condor you do an 
arithmetic distance calculation. 

For 5x5, Condor opposite corner distance is (2*(5x23040)^2)^0.5 =  162.92 Km

Great-circle calculations for one diagonal is: 162.85 km, the other diagonal is: 162.84 km

As you fly in Condor, you are totally un-aware of any distortion. Reaching a turn-point is simply a few 
more metres away than in real-life, and for a 5x5 about 250 feet over 100 mi.
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NEXT REV NOTES:

                                                                                                                                        he Landscape 
Editor draws the airport G file with asphalt and grass areas, as well as the defined runway.

Condor_Tiles draws the defined runway and its centre (red), and three items in blue: 1) the glider take-
off path on the left, the tow plane landing path on the right with its return to the take-off position, and 
the standard position of a windsock (square).

- Adding Trees,  Flatening

                                                                                                                                                           
NOTE:  I noticed you didn't have a runway.  Right now they aren't covered in our Tutorial.  I can give 
you one tip for a smoother takeoff.  Load your scenery in the landscape editor.  Click on 'Airports' and 
zoom in on your location.  Then click on 'Height map' and you will see a bunch of elevation numbers.  
Then click on 'FLATTEN'.  Set the 'Altitude' to what you used for the Airport, and then to start an 
'Edge slope' of about 1:3 and a 'Radius' about 25 pt.  When you move your cursor you will see two 
circles.  The inner circle will be forced to that exact elevation, the outer circle will be a slop area for a 
gradual transition.

    Makes for a much smoother takeoff.   You have to go thru all the save steps as below. WARNING - 
there is no easy way to undo these changes!
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 APPENDIX FIVE –   GNU Free Documentation License
Reference:      https://www.gnu.org/licenses/fdl-1.3.en.html

Version 1.3, 3 November 2008

Copyright © 2000, 2001, 2002, 2007, 2008 Free Software Foundation, Inc. <https://fsf.org/> 

Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it 
is not allowed.

0. PREAMBLE

The purpose of this License is to make a manual, textbook, or other functional and useful document 
"free" in the sense of freedom: to assure everyone the effective freedom to copy and redistribute it, with
or without modifying it, either commercially or noncommercially. Secondarily, this License preserves 
for the author and publisher a way to get credit for their work, while not being considered responsible 
for modifications made by others.

This License is a kind of "copyleft", which means that derivative works of the document must 
themselves be free in the same sense. It complements the GNU General Public License, which is a 
copyleft license designed for free software.

We have designed this License in order to use it for manuals for free software, because free software 
needs free documentation: a free program should come with manuals providing the same freedoms that 
the software does. But this License is not limited to software manuals; it can be used for any textual 
work, regardless of subject matter or whether it is published as a printed book. We recommend this 
License principally for works whose purpose is instruction or reference.

1. APPLICABILITY AND DEFINITIONS

This License applies to any manual or other work, in any medium, that contains a notice placed by the 
copyright holder saying it can be distributed under the terms of this License. Such a notice grants a 
world-wide, royalty-free license, unlimited in duration, to use that work under the conditions stated 
herein. The "Document", below, refers to any such manual or work. Any member of the public is a 
licensee, and is addressed as "you". You accept the license if you copy, modify or distribute the work 
in a way requiring permission under copyright law.

A "Modified Version" of the Document means any work containing the Document or a portion of it, 
either copied verbatim, or with modifications and/or translated into another language.

A "Secondary Section" is a named appendix or a front-matter section of the Document that deals 
exclusively with the relationship of the publishers or authors of the Document to the Document's 
overall subject (or to related matters) and contains nothing that could fall directly within that overall 
subject. (Thus, if the Document is in part a textbook of mathematics, a Secondary Section may not 
explain any mathematics.) The relationship could be a matter of historical connection with the subject 
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or with related matters, or of legal, commercial, philosophical, ethical or political position regarding 
them.

The "Invariant Sections" are certain Secondary Sections whose titles are designated, as being those of 
Invariant Sections, in the notice that says that the Document is released under this License. If a section 
does not fit the above definition of Secondary then it is not allowed to be designated as Invariant. The 
Document may contain zero Invariant Sections. If the Document does not identify any Invariant 
Sections then there are none.

The "Cover Texts" are certain short passages of text that are listed, as Front-Cover Texts or Back-
Cover Texts, in the notice that says that the Document is released under this License. A Front-Cover 
Text may be at most 5 words, and a Back-Cover Text may be at most 25 words.

A "Transparent" copy of the Document means a machine-readable copy, represented in a format whose
specification is available to the general public, that is suitable for revising the document 
straightforwardly with generic text editors or (for images composed of pixels) generic paint programs 
or (for drawings) some widely available drawing editor, and that is suitable for input to text formatters 
or for automatic translation to a variety of formats suitable for input to text formatters. A copy made in 
an otherwise Transparent file format whose markup, or absence of markup, has been arranged to thwart
or discourage subsequent modification by readers is not Transparent. An image format is not 
Transparent if used for any substantial amount of text. A copy that is not "Transparent" is called 
"Opaque".

Examples of suitable formats for Transparent copies include plain ASCII without markup, Texinfo 
input format, LaTeX input format, SGML or XML using a publicly available DTD, and standard-
conforming simple HTML, PostScript or PDF designed for human modification. Examples of 
transparent image formats include PNG, XCF and JPG. Opaque formats include proprietary formats 
that can be read and edited only by proprietary word processors, SGML or XML for which the DTD 
and/or processing tools are not generally available, and the machine-generated HTML, PostScript or 
PDF produced by some word processors for output purposes only.

The "Title Page" means, for a printed book, the title page itself, plus such following pages as are 
needed to hold, legibly, the material this License requires to appear in the title page. For works in 
formats which do not have any title page as such, "Title Page" means the text near the most prominent 
appearance of the work's title, preceding the beginning of the body of the text.

The "publisher" means any person or entity that distributes copies of the Document to the public.

A section "Entitled XYZ" means a named subunit of the Document whose title either is precisely XYZ 
or contains XYZ in parentheses following text that translates XYZ in another language. (Here XYZ 
stands for a specific section name mentioned below, such as "Acknowledgements", "Dedications", 
"Endorsements", or "History".) To "Preserve the Title" of such a section when you modify the 
Document means that it remains a section "Entitled XYZ" according to this definition.

The Document may include Warranty Disclaimers next to the notice which states that this License 
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applies to the Document. These Warranty Disclaimers are considered to be included by reference in 
this License, but only as regards disclaiming warranties: any other implication that these Warranty 
Disclaimers may have is void and has no effect on the meaning of this License.

2. VERBATIM COPYING

You may copy and distribute the Document in any medium, either commercially or noncommercially, 
provided that this License, the copyright notices, and the license notice saying this License applies to 
the Document are reproduced in all copies, and that you add no other conditions whatsoever to those of
this License. You may not use technical measures to obstruct or control the reading or further copying 
of the copies you make or distribute. However, you may accept compensation in exchange for copies. 
If you distribute a large enough number of copies you must also follow the conditions in section 3.

You may also lend copies, under the same conditions stated above, and you may publicly display 
copies.

3. COPYING IN QUANTITY

If you publish printed copies (or copies in media that commonly have printed covers) of the Document,
numbering more than 100, and the Document's license notice requires Cover Texts, you must enclose 
the copies in covers that carry, clearly and legibly, all these Cover Texts: Front-Cover Texts on the 
front cover, and Back-Cover Texts on the back cover. Both covers must also clearly and legibly 
identify you as the publisher of these copies. The front cover must present the full title with all words 
of the title equally prominent and visible. You may add other material on the covers in addition. 
Copying with changes limited to the covers, as long as they preserve the title of the Document and 
satisfy these conditions, can be treated as verbatim copying in other respects.

If the required texts for either cover are too voluminous to fit legibly, you should put the first ones 
listed (as many as fit reasonably) on the actual cover, and continue the rest onto adjacent pages.

If you publish or distribute Opaque copies of the Document numbering more than 100, you must either 
include a machine-readable Transparent copy along with each Opaque copy, or state in or with each 
Opaque copy a computer-network location from which the general network-using public has access to 
download using public-standard network protocols a complete Transparent copy of the Document, free 
of added material. If you use the latter option, you must take reasonably prudent steps, when you begin 
distribution of Opaque copies in quantity, to ensure that this Transparent copy will remain thus 
accessible at the stated location until at least one year after the last time you distribute an Opaque copy 
(directly or through your agents or retailers) of that edition to the public.

It is requested, but not required, that you contact the authors of the Document well before redistributing
any large number of copies, to give them a chance to provide you with an updated version of the 
Document.

4. MODIFICATIONS

You may copy and distribute a Modified Version of the Document under the conditions of sections 2 
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and 3 above, provided that you release the Modified Version under precisely this License, with the 
Modified Version filling the role of the Document, thus licensing distribution and modification of the 
Modified Version to whoever possesses a copy of it. In addition, you must do these things in the 
Modified Version:

 A. Use in the Title Page (and on the covers, if any) a title distinct from that of the Document, 
and from those of previous versions (which should, if there were any, be listed in the History 
section of the Document). You may use the same title as a previous version if the original 
publisher of that version gives permission. 

 B. List on the Title Page, as authors, one or more persons or entities responsible for authorship 
of the modifications in the Modified Version, together with at least five of the principal authors 
of the Document (all of its principal authors, if it has fewer than five), unless they release you 
from this requirement. 

 C. State on the Title page the name of the publisher of the Modified Version, as the publisher. 

 D. Preserve all the copyright notices of the Document. 

 E. Add an appropriate copyright notice for your modifications adjacent to the other copyright 
notices. 

 F. Include, immediately after the copyright notices, a license notice giving the public permission
to use the Modified Version under the terms of this License, in the form shown in the 
Addendum below. 

 G. Preserve in that license notice the full lists of Invariant Sections and required Cover Texts 
given in the Document's license notice. 

 H. Include an unaltered copy of this License. 

 I. Preserve the section Entitled "History", Preserve its Title, and add to it an item stating at least 
the title, year, new authors, and publisher of the Modified Version as given on the Title Page. If 
there is no section Entitled "History" in the Document, create one stating the title, year, authors, 
and publisher of the Document as given on its Title Page, then add an item describing the 
Modified Version as stated in the previous sentence. 

 J. Preserve the network location, if any, given in the Document for public access to a 
Transparent copy of the Document, and likewise the network locations given in the Document 
for previous versions it was based on. These may be placed in the "History" section. You may 
omit a network location for a work that was published at least four years before the Document 
itself, or if the original publisher of the version it refers to gives permission. 

 K. For any section Entitled "Acknowledgements" or "Dedications", Preserve the Title of the 
section, and preserve in the section all the substance and tone of each of the contributor 
acknowledgements and/or dedications given therein. 

 L. Preserve all the Invariant Sections of the Document, unaltered in their text and in their titles. 
Section numbers or the equivalent are not considered part of the section titles. 

 M. Delete any section Entitled "Endorsements". Such a section may not be included in the 
Modified Version. 
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 N. Do not retitle any existing section to be Entitled "Endorsements" or to conflict in title with 
any Invariant Section. 

 O. Preserve any Warranty Disclaimers. 

If the Modified Version includes new front-matter sections or appendices that qualify as Secondary 
Sections and contain no material copied from the Document, you may at your option designate some or
all of these sections as invariant. To do this, add their titles to the list of Invariant Sections in the 
Modified Version's license notice. These titles must be distinct from any other section titles.

You may add a section Entitled "Endorsements", provided it contains nothing but endorsements of your
Modified Version by various parties—for example, statements of peer review or that the text has been 
approved by an organization as the authoritative definition of a standard.

You may add a passage of up to five words as a Front-Cover Text, and a passage of up to 25 words as a
Back-Cover Text, to the end of the list of Cover Texts in the Modified Version. Only one passage of 
Front-Cover Text and one of Back-Cover Text may be added by (or through arrangements made by) 
any one entity. If the Document already includes a cover text for the same cover, previously added by 
you or by arrangement made by the same entity you are acting on behalf of, you may not add another; 
but you may replace the old one, on explicit permission from the previous publisher that added the old 
one.

The author(s) and publisher(s) of the Document do not by this License give permission to use their 
names for publicity for or to assert or imply endorsement of any Modified Version.

5. COMBINING DOCUMENTS

You may combine the Document with other documents released under this License, under the terms 
defined in section 4 above for modified versions, provided that you include in the combination all of 
the Invariant Sections of all of the original documents, unmodified, and list them all as Invariant 
Sections of your combined work in its license notice, and that you preserve all their Warranty 
Disclaimers.

The combined work need only contain one copy of this License, and multiple identical Invariant 
Sections may be replaced with a single copy. If there are multiple Invariant Sections with the same 
name but different contents, make the title of each such section unique by adding at the end of it, in 
parentheses, the name of the original author or publisher of that section if known, or else a unique 
number. Make the same adjustment to the section titles in the list of Invariant Sections in the license 
notice of the combined work.

In the combination, you must combine any sections Entitled "History" in the various original 
documents, forming one section Entitled "History"; likewise combine any sections Entitled 
"Acknowledgements", and any sections Entitled "Dedications". You must delete all sections Entitled 
"Endorsements".
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6. COLLECTIONS OF DOCUMENTS

You may make a collection consisting of the Document and other documents released under this 
License, and replace the individual copies of this License in the various documents with a single copy 
that is included in the collection, provided that you follow the rules of this License for verbatim 
copying of each of the documents in all other respects.

You may extract a single document from such a collection, and distribute it individually under this 
License, provided you insert a copy of this License into the extracted document, and follow this 
License in all other respects regarding verbatim copying of that document.

7. AGGREGATION WITH INDEPENDENT WORKS

A compilation of the Document or its derivatives with other separate and independent documents or 
works, in or on a volume of a storage or distribution medium, is called an "aggregate" if the copyright 
resulting from the compilation is not used to limit the legal rights of the compilation's users beyond 
what the individual works permit. When the Document is included in an aggregate, this License does 
not apply to the other works in the aggregate which are not themselves derivative works of the 
Document.

If the Cover Text requirement of section 3 is applicable to these copies of the Document, then if the 
Document is less than one half of the entire aggregate, the Document's Cover Texts may be placed on 
covers that bracket the Document within the aggregate, or the electronic equivalent of covers if the 
Document is in electronic form. Otherwise they must appear on printed covers that bracket the whole 
aggregate.

8. TRANSLATION

Translation is considered a kind of modification, so you may distribute translations of the Document 
under the terms of section 4. Replacing Invariant Sections with translations requires special permission 
from their copyright holders, but you may include translations of some or all Invariant Sections in 
addition to the original versions of these Invariant Sections. You may include a translation of this 
License, and all the license notices in the Document, and any Warranty Disclaimers, provided that you 
also include the original English version of this License and the original versions of those notices and 
disclaimers. In case of a disagreement between the translation and the original version of this License 
or a notice or disclaimer, the original version will prevail.

If a section in the Document is Entitled "Acknowledgements", "Dedications", or "History", the 
requirement (section 4) to Preserve its Title (section 1) will typically require changing the actual title.

9. TERMINATION

You may not copy, modify, sublicense, or distribute the Document except as expressly provided under 
this License. Any attempt otherwise to copy, modify, sublicense, or distribute it is void, and will 
automatically terminate your rights under this License.
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However, if you cease all violation of this License, then your license from a particular copyright holder
is reinstated (a) provisionally, unless and until the copyright holder explicitly and finally terminates 
your license, and (b) permanently, if the copyright holder fails to notify you of the violation by some 
reasonable means prior to 60 days after the cessation.

Moreover, your license from a particular copyright holder is reinstated permanently if the copyright 
holder notifies you of the violation by some reasonable means, this is the first time you have received 
notice of violation of this License (for any work) from that copyright holder, and you cure the violation
prior to 30 days after your receipt of the notice.

Termination of your rights under this section does not terminate the licenses of parties who have 
received copies or rights from you under this License. If your rights have been terminated and not 
permanently reinstated, receipt of a copy of some or all of the same material does not give you any 
rights to use it.

10. FUTURE REVISIONS OF THIS LICENSE

The Free Software Foundation may publish new, revised versions of the GNU Free Documentation 
License from time to time. Such new versions will be similar in spirit to the present version, but may 
differ in detail to address new problems or concerns. See https://www.gnu.org/licenses/.

Each version of the License is given a distinguishing version number. If the Document specifies that a 
particular numbered version of this License "or any later version" applies to it, you have the option of 
following the terms and conditions either of that specified version or of any later version that has been 
published (not as a draft) by the Free Software Foundation. If the Document does not specify a version 
number of this License, you may choose any version ever published (not as a draft) by the Free 
Software Foundation. If the Document specifies that a proxy can decide which future versions of this 
License can be used, that proxy's public statement of acceptance of a version permanently authorizes 
you to choose that version for the Document.

11. RELICENSING

"Massive Multiauthor Collaboration Site" (or "MMC Site") means any World Wide Web server that 
publishes copyrightable works and also provides prominent facilities for anybody to edit those works. 
A public wiki that anybody can edit is an example of such a server. A "Massive Multiauthor 
Collaboration" (or "MMC") contained in the site means any set of copyrightable works thus published 
on the MMC site.

"CC-BY-SA" means the Creative Commons Attribution-Share Alike 3.0 license published by Creative 
Commons Corporation, a not-for-profit corporation with a principal place of business in San Francisco,
California, as well as future copyleft versions of that license published by that same organization.

"Incorporate" means to publish or republish a Document, in whole or in part, as part of another 
Document.

An MMC is "eligible for relicensing" if it is licensed under this License, and if all works that were first 
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published under this License somewhere other than this MMC, and subsequently incorporated in whole
or in part into the MMC, (1) had no cover texts or invariant sections, and (2) were thus incorporated 
prior to November 1, 2008.

The operator of an MMC Site may republish an MMC contained in the site under CC-BY-SA on the 
same site at any time before August 1, 2009, provided the MMC is eligible for relicensing.
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 APPENDIX SIX –   Misc: Turnpoint files, splash images                  

Turnpoints -  If you look in the top folder of your landscape, you will find a <landscape>.cup (just put
your turnpoints in that file). 

Splash Screen Images – These are displayed while Condor2 is loading your landscape.  Theses are 
stored in the <landscape>\Images folder (just check Slovenia), they are .jpg, 1920x1080, and use a 
number for the name.  It will cycle thru them.

Below are some other notes on turnpoint usage and  formatting:

*  On your first use of a landscape the turnpoints are loaded from
   a file in the landscape directory with the name <landscape>.cup

*  After first use Condor stores a copy of the turnpoints in a
   file located in Documents\Condor\Turnpoints\<landscape>.cup
   It then uses that file exclusively and ignores any changes you
   might make to the turnpoint file in the landscapes directory.

*  If changes are made to the turnpoints file in the landscape
   directory with a new release of the landscape, you must delete
   the turnpoint file in the Documents\Condor\Turnpoints folder
   first before starting Condor.  It will then use the new file.

*  Visibility of turnpoints depends on the "Style" field being a '1' in
   the turnpoints file followed by no other data.  If something is not
   showing up, try changing the value, perform the steps above,
   stop/start Condor, and it should appear.  Example:

Before:
"Yadkinville","YADKNVLL",US,3608.550N,08043.083W,1050ft,3,,1200ft,,"Turn Point, 
Landable, Land to the East, RW width: 50"

After:
"Yadkinville","YADKNVLL",US,3608.550N,08043.083W,1050ft,1,,,,

*  You can create your own turnpoints in the Flight Planner by clicking
   right and selecting "New" -> "Turnpoint".  Those will be stored in
   your Documents directory copy only.
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